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What’s New

RobotStudio 5.14

1 What’s New in this Release?

Overview

This document provides information about the new features in this release.

1.1 Microsoft Office 2010 Fluent User Interface
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Fluent Ul
The RobotStudio 5.14 user interface is redesigned and now uses the Microsoft Office
Fluent user interface (Ul). Introduced in the RobotStudio 5.11, the Fluent Ul is
designed to make it easier for people to find and use the full range of features that
RobotStudio provide, and to preserve an uncluttered workspace.

The Ribbon

The ribbon, part of the Fluent Ul, was designed to optimize key RobotStudio scenarios
to make them easier to use. The ribbon provides quicker access to all the commands in
RobotStudio and allows for easier future additions and customizations. You can make
your favorite commands available in the quick access toolbar, embedded in the title bar.
To help maximize the space of the graphical viewer, the ribbon can be hidden.

Backstage View

The Microsoft Office Backstage is part of the Fluent Ul and a companion feature to the
ribbon. The Backstage view, which can be accessed from the File menu, helps you find
frequently used features for managing RobotStudio files. (The File tab replaces the
RobotStudio Button and File menu that were used in earlier releases of RobotStudio.)

© Copyright 2011 ABB All rights reserved 3



What’s New

RobotStudio 5.14

1.2 Activation and Licensing

Version independent activation key: RobotStudio 5.x

Starting with RobotStudio 5.14, the activation key that activates RobotStudio 5.14 will
also activate all future versions (both major and minor) of RobotStudio 5. This is
indicated by the version of the installed license key in RobotStudio. The version
displayed in the license information dialog is now 5.x.

Licenses

Installed license keys

Feature Version Type Expires Status o
Robot Studio Full 5x Standalone 2011-04-30 Valid -

1.3 General

Document Manager References

References to files and folders can be added to a station through the Document
Manager. Referenced folders can optionally be included in the Pack and Go file. There
is also an option to completely embed a file in the station.

Documents 7o

Q) Station () Search () Browse

Add -

File Reference...

Folder Reference...
Embedded File..
New Text Document

TYTEM
& 2011-02-02: 139 KB

SW3dPS-R8-body SAT
2011-02-08; 2854 KB

Electrical
] C\Users\seheber4\Do.
@l Ci\Users\sehebert\Do...

4item(s)

New Robot Models

Simulation models for the following new robots have been added to RobotStudio
e IRB2600ID (15kg/1.85m)
e IRB2600ID (8kg/2.0m)
e [|RB460
e [RB760
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Station name in title bar

The name of the currently opened station has been added to the title bar.
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Improvements of CAD based path generation (AutoPath)

The function ’Path from Curve’ for automatic creation of path based on a curve, has
been improved. It is not longer required to have a curve prepared as it can work on the
edges of a piece of geometry. Of course, if a curve is available, it can be used for the
path generation as before. The user interface has been simplified and advanced options
for angle tuning, approach and depart targets removed. Also, a preview of the path is
available to indicate what the result will be before the command is executed.

Tuning of targets can be done through the new Reference Frame available in the Set
Position and Rotate tools. Approach and depart targets can be created using the regular
copy/paste functions in combination with the tuning feature. The function has been
renamed to AutoPath to reflect the re-design.

Online Monitor

The Online Monitor can be described as a virtual web camera that monitors the
connected robot and visualizes its movements. The graphical view that shows the robot
model is updated with the true robot position every second. If the robot is in a singular

position or at a joint limit you will get an indication in the view. Only TCP robots will
be shown as external axes are not supported.
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Adjust Robtargets

The Premium feature Adjust Robtargets allows programs that has been programmed
with the wrong TCP (tooldata) or work object (wobjdata) to be corrected. The joint

angles of the robot will remain the same.

7 Demo AW Station - ABB Robotstucio 5.14

Accelerated simulation

An option to run the simulation as fast as possible has been added to the Simulation
Accuracy section of the RobotStudio options. With this option selected, RobotStudio
will fire the next time step as soon as the calculation for the previous one is completed.
The predicted execution times for the Virtual Controllers will not be affected.

Options*

Accuracy

Smuation
Smusin

Station Viewer Improvements: Acceleration and Seek Bar

The simulation replay of the Station Viewer can now accelerated up to 200% of the
normal execution speed. It is also possible to reduce the time or even play the
simulation backwards. In addition, a seek bar has been added that shows simulation

progress and allows the simulation to be started at a particular point.
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Simulation Step / Pause / Resume

A simulation can now be stepped forward one tick at the time. First, start the simulation
as usual by pressing the Play button. Then, you can pause the simulation by pressing
the Pause button. When paused, the Play button will be renamed to Resume, and the
Pause button will be renamed into Step. Now, the simulation can be stepped forward

one time step (tick) at the time by pressing the Step button.

Before starting the simulation the Play button is enabled. When the simulation is
running, the Pause button is enabled. When paused, the Play, and Pause buttons are

renamed, Resume and Step, respectively, see below.

Simulation Offline Onli
b bl B N
Play Pause Stop Reset

I Simulation Control [

Simulation Offline Onli

b M @ N

Pause Stop Reset

) {4 Simulation Control [F1 ) 1

Simulation Offline Online

b M @ N

Resume Step Stop Reset

Simulation Control [

ScreenRecorder support for Microsoft Windows Media format

Support for Windows Media version 8 and 9 has been added to the Screen Recorder.
In addition, movies can be recorded using the H.264 / MPEG-4 encoder that creates
high-quality recordings with a high compression ratio. The AVI format is still available

and allows the selection of any available codec on the computer.

Optionsd N b ¥
General —| | Screen Recorder
Appearance
Licensing Framerate (frames/s): 20
nits Note: Will not affect "Record Simulation”
Advanced Start recording after (s): 05
Files & Folders = | | [[] Stop recording after (s) 0.0
Screenshot _
EEEEEE © Resolution © Same as window
Sereen Recorder* | -
Limit resolution
Roboties Maximum width (pixels) 800
Editor Maximum height (pixels) 600 :
Rapid L
Synchronization Video Compression Windows Media Video 9 -
Mechanism Location
Virtual Controller C\Usersiseheberd\Videos =]
Online File name (unique suffix will be appended)
RobotStudio Wy -
Authentication
Terminal i Apply ] [ Reset ] [ Default ]

NOTE!

The Microsoft Windows Media and H.264 encoders are only available for Windows 7,

not for Windows XP.
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Transparent textures

To simply modeling and increase realism, support for transparent textures has been
added to RobotStudio. The textures are applied using the Graphical Appearance tool.
The feature supports textures in . PNG format.

Target Reference Frame

The reference frame of a target has now been exposed in RobotStudio. Until now, it has
only been available in ArcWelding PowerPac. The target reference frame allows a
target to be offset relative to the original position. This is useful if the targets have been
created using a CAD-model and it is required to offset the target position to compensate
for the robot tool. The Reference Frame is available in the Set Position and Rotate
tools

Improved performance for Configurations and AutoConfig

The different ways a robot arm can use to reach a certain target is controlled by the
confdata in RAPID and can be set using the Configurations tool in RobotStudio.
The performance of the calculation of the available arm configurations are now done
directly by the virtual controller, which gives a dramatic increase in performance. The
improved performance can be seen when using RobotWare 5.14.

© Copyright 2011 ABB All rights reserved 8
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Collision Detection performance improved.

The Collision Detection computation has been improved to make use of multiple CPU
cores, if available, and uses the SSE (Streaming SIMD Extensions) instruction set for
best performance.

Nine decimals in generated RAPID code

The number of decimals used for specifying the position and orientation data of
generated robtargets, tooldata, and wobjdata are now limited to nine. This
will increase readability of the generated RAPID code. Accuracy is not affected since
the data is declared in RAPID as num (single precision) that uses the eight first
decimals.

Markups

A markup is a text box displayed in the 3D graphics. It can be used to highlight areas of
interest. Markups become part of the Station Viewer.

efAnother Markup
u«“‘“‘w

AutoConfig options
New options related to AutoConfig
e Verify. Verifies existing configuration

e Reset. Marks current configuration as unverified to enable for optimization using

AutoConfig
Configurations | =, | Auto Configuration
Path » Reset Configurations
Modify External Auxis... Verify Configurations
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Signal Analyzer

Signals to be analyzed are defined in the Signal Setup tool for viewing and analysis in
the Signal Analyzer. The tool allows robot performance tuning and signal debugging.

The table below lists the signals that can be analyzed and their dependency on

RobotWare..
Signal name RW availability
Controller Signals / <system name> / EventLog
<domain> Any RW version
Controller Signals / <system name>/ Mechanical Units / /0O System
<all signals> Any RW version
Controller Signals / <system name> / Mechanical Units / ROB_x / Joint
J1-J6 Any RW version
Near Limit Any RW version
Controller Signals / <system name> / Mechanical Units / ROB_x / Target
Fine Point Any RW version
Target Reached Any RW version
Controller Signals / <system name> / Mechanical Units / ROB_x / TCP
Maximum Linear Acceleration in World* RW version = 5.14

Orientation Q1-Q4 Current Workobject RW version 2 5.14
Orientation Speed in Current Workobject ~ RW version 2 5.14

Pos X, Y, Z in Current Workobject RW version = 5.14

Robot Configuration cfl, cf4, cf6, cfx RW version = 5.14

Speed in Current Workobject RW version = 5.14

Total Motor Power RW version 2 5.14
Smart Components

<all signals> <no RW needed>

The Signals are visualized in the graph below.

Using the Signal History tool, signal recordings can be exported to Excel, renamed, or
deleted.

H NOTE!
The maximum number of signals that can be exported is limited to 26.

! The signal "Maximum Linear Acceleration in World’ provides the maximum acceleration of the
current move instruction.
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RAPID Profiler

The new RAPID Profiler is a tool for measuring and analyzing procedure execution
times of the robot program. It is a Premium feature that can be used to identify the
critical procedures that offer great potential for cycle time reduction. Special attention is
paid to Wait-instructions and MultiMove synchronization semaphores. Reducing
waiting times is the obvious way to reduce the program execution time.

RAPID Profiler120_ROB2

Procedures | WaitTimes

Task Procedurs Time (il subs) Time (sxcl subs)

PickPanel 852 % [35111 ms] 852% [35111 ms]

T_ROE1 FlacePaneiOnOutFeeder 9.1% [3733ms] 9.1% [3733ms]

T_ROB1 PlacePanelinCortrolBuffer | 5.7 % [2345ms] 57 % [2345ms]
Shaw TASK.cnly: <ALL> - [ Export to Excel ] [ oK ]

RAPID Profiler:120 ROB2

Procedures | Wat Times

Task Procedure Instruction Time |
T_ROE1 PickPanel WatDI diCelinPickPos, 1; 27821 ms

PickPanel WatDI diCelinPickPos. 1

T_ROB1 PickPanel ‘WaiDl diCellinPickPos,1; 1248 ms
T_ROB1 PickPanel WatDI diVacuum, 1: 44ms
T_ROE1 FickPanel WatD! diVacuum,1; 44ms
T_ROB1 PlacePanelOnOutFeeder | WatDl diViacuum,0; 4ms
T_ROB1 PlacePanelinControlBuffer | WatDl diVacuum.0: 37ms
T_ROE1 PickPanel WatDI diVacuum,1; 28ms
T_ROB1 PlacePanelOnOutFeeder | WatDl divacuum.0; 28ms
Show TASK anly. <ALL> - [ Export to Excel ] [ 0K ]

H NOTE!

e The Spy function does not produce useful output for systems based on the
RobotWare option CAP (Continuous Application Platform). This is the case for e.g.
systems with ArcWelding. This affects the RAPID Profiler that analyses the log
generated by the Spy function.

e For accurate results, the last move instruction of all procedures should be a fine
point. Otherwise the estimated time for that procedure will be underestimated.

External axis interpolation

Defines optimal external axis value with respect to robot TCP
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1.4 Smart Component Improvements

Smart Component: LogicExpression

A gate whose output is determined by a logic expression. Supports logic operators
AND, OR, NOT and XOR. Advanced gates can be easily created using the
LogicExpression gate. The overall complexity of a smart component is reduced since
the gate logic can be handled by one base component.

Example: output = input5 XOR (inputl AND input2) OR (NOT input3)

Smart Component Viewer Filter

The objects of the SmartComponent viewer can now be filtered to reduce the
complexity.

e signals
e properties

e only connected components

Property Detectable added to graphical objects
Allows graphical objects to be made invisible to SmartComponent sensors

1.5 ScreenMaker Improvements

Language Support

ScreenMaker supports the same set of languages that RobotStudio supports. The
languages are applicable for the User Interface which includes the ribbon and dialogs
and not for the controls and its properties .

ScreenMaker Templates

ScreenMaker now includes the three templates Basic, Advanced and Extended, which
represent typical uses of ScreenaMaker.

Launch Virtual Flexpendant after deploying

The new option to automatically launch the Virtual FlexPendant after the current
ScreenMaker application have been deployed is available in the ScreenMaker
properties.

Access of shared data

Shared RAPID data can now be accessed using ScreenMaker

© Copyright 2011 ABB All rights reserved 12
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Conditional Trigger Control

A new control for configuring the execution of events based on condition. The
following table describes the conditions and datatypes supported

Condition RAPID Signals Application Variables
AND bool NA bool

OR bool NA bool

XOR bool NA bool

NOTEQUAL  Any Type Any Type Any Type

EQUAL Any Type Any Type Any Type

GREATER num, dnum num, dnum num, dnum (0/1)
LESSER num, dnum num, dnum num, dnum(0/1)

ScreenMaker Doctor detects missing RAPID and Signal data

The ScreenMaker Doctor now detects missing RAPID and Signal data that has been
bound in the ScreenMaker project but does not exist in the connected controller. The
ScreenMaker project must be connected to the controller to detect RAPID and Signal
data. The ScreenMaker Doctor does not detect actions that are defined as part of events.
For example: If an action has been defined to Read Rapid Data into Application
Variable.

Increment / Decrement control

A new control for incrementing and decrementing a NUM/DNUM.

© Copyright 2011 ABB All rights reserved 13
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